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About this book

This book provides instructions for installing and using IBM® Software Configuration
and Library Manager (SCLM) Administrator Toolkit.

This book is designed to help SCLM project administrators and installation personnel
perform these tasks:
* Define new SCLM projects and modify existing projects

¢ Perform required SCLM language and architecture definitions; maintain VSAM
files, and import software assets into an SCLM project

e Maintain IBM Enhanced Access Control for SCLM for z/OS® (EAC) data set
profiles, profile access files, settings, and applications

¢ List and review Enhanced Access Control for SCLM violations
¢ Diagnose and recover from SCLM Administrator Toolkit problems
e Use SCLM Administrator Toolkit with other products comprising IBM’s SCLM

Suite.

Always check the SCLM Administrator Toolkit Library page for the most current
version of this publication:

http:/ /www.ibm.com/software /awdtools/sclmsuite /admintoolkit

This book is a companion to the IBM SCLM Administrator Toolkit: Installation and
Customization Guide, GC31-6787. See that manual for information about installing and
configuring SCLM Administrator Toolkit.

Who should read this book

This book is intended for those persons wanting to learn about and use SCLM
Administrator Toolkit to administer SCLM. This book assumes a working knowledge
of:

® The z/OS operating system
e IBM Eclipse SDK (IES) Version 3.0 or higher

e ISPF

¢ SCLM

¢ EAC

e SMP/E

e RACF®, for those users that will administer Enhanced Access Control for SCLM
for z/OS

Conventions used in this book

This book uses the following highlighting conventions:

¢ Boldface type indicates commands or user interface controls such as names of
fields, folder, icons, or menu choices.

* Monospace type indicates examples of text that you enter exactly as shown.

® [talic type indicates variables that you should replace with a value. It is also used
to indicate book titles and to emphasize significant words.
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The following labels identify significant elements within this book:
* Definition: is used to identify and define terminology unique to this product.
e Example: is used to identify example code or scenarios.

e In this chapter: is used to identify the significant subsections within each chapter.

* Recommendation: is used to provide guidance when more than one option is
available.

* Related reading: is used to refer you to other publications that contain relevant
information.

¢ Restriction: is used to identify a restriction or limitation with this product or an
associated procedure.

Terminology used in this book

In this book, Software Configuration and Library Manager (SCLM) Administrator
Toolkit is referred to as “SCLM Administrator Toolkit.” Where the meaning is clear,
the product may be referred to simply as the Toolkit, IBM Enhanced Access Control
for SCLM for z/OS is referred to as "Enhanced Access Control for SCLM," or in
message text or where space is limited, simply as "EAC." IBM Breeze for SCLM for
z/OS is referred to as "Breeze."

Service updates and support information

To find service updates and support information, including software FixPaks, PTFs,
Frequently Asked Question (FAQs), technical notes, troubleshooting information, and
downloads, refer to the following Web page:

http:/ /www.ibm.com /software /awdtools/sclmsuite /admintoolkit

Using LookAt to obtain message explanations

LookAt is an online facility that displays explanations for most messages that you
encounter, as well as for some system abends and codes. You can access LookAt:

e  From the Internet at:
www.ibm.com/eserver/zseries/zos/bkserv /lookat/

¢ From anywhere in z/OS where you can access a TSO/E command line (for
example, a TSO/E prompt, ISPF, or z/OS UNIX System Services running OMVS).
To use LookAt as a TSO/E command, LookAt must be installed on your host
system. Obtain the LookAt code for TSO/E from a disk on your z/OS Collection
(SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/ZOS/

e From your Palm™ VIIx personal data assistant (PDA). To use LookAt from your
Palm VIIx PDA, LookAt must be installed on the PDA. Obtain the LookAt code
from a disk on your z/OS Collection (SK3T-4269) or from the LookAt ftp site:

ftp.software.ibm.com/ps/products/ibmreader/tools/lookat/ PALM/

Where to find information

The SCLM Suite Web page and web pages for the component products of the SCLM
Suite provide current product documentation that you can view, print, and download.
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To locate publications with the most up-to-date information, refer to the following
Web pages:

http:/ /www-3.ibm.com/software/awdtools/sclmsuite /sclm/library
IBM Redbooks® that cover the SCLM Suite are available from the following Web page:

http:/ /publib-b.boulder.ibm.com/Redbooks.nsf
/Redbooks?SearchView&Query=sclm

The documentation for the SCLM Administrator Toolkit is found at the following web
page:

http:/ /www.ibm.com /software /awdtools/sclmsuite /admintoolkit

Accessibility features

Accessibility features help a user who has a physical disability, such as restricted
mobility or limited vision, to use a software product successfully. The major
accessibility features in SCLM Administrator Toolkit enable users to:

¢ Use assistive technologies such as screen readers and screen magnifier software.
Consult the assistive technology documentation for specific information when
using it to access z/OS interfaces.

e Customize display attributes such as color, contrast, and font size.

* Operate specific or equivalent features using only the keyboard. Refer to the
following publications for information about accessing ISPF interfaces:

— z/OS ISPF User’s Guide, Volume 1, SC34-4822
— z/OS TSO/E Primer, SA22-7787
— z/OS TSOJE User’s Guide, SA22-7794

These guides describe how to use ISPF, including the use of keyboard shortcuts or
function keys (PF keys), include the default settings for the PF keys, and explain
how to modify their functions.

Navigating in a workstation panel

When you use the Tab key to navigate through a workstation panel, as you move from
field to field, one of the letters in each of the descriptions is underlined. This provides
a keyboard shortcut to the field in question. This behavior does not occur when using
the mouse to select a field on the panel.

Copying and pasting while using the workstation interface

If you want to copy information from a text field or paste information into a text field,
place your cursor in the field in question. To copy, select the text to be copied, right-
click in the text field, and select Copy from the pop-up menu. To paste information
into a text field, place your cursor into the field in question, right-click, and select
Paste from the pop-up menu. Ctrl+C and Ctrl+A, respectively, copy selected text or
all text to the clipboard for your use. Ctrl+V pastes the text to a place you select.

How to send your comments

Your feedback is important in helping to provide the most accurate and high-quality
information. If you have any comments about this book or any other SCLM
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Administrator Toolkit documentation, print and fill out the reader comment form
located at the back of this book. You can use the following methods to return the form:

Give it to your local IBM branch office or IBM representative.
Send it to the address printed on the reader comment form.

Send your comments by e-mail to comments@us.ibm.com.

Before you begin

Before you can begin to use SCLM Administrator Toolkit, customization of the host
component as described in the IBM SCLM Administrator Toolkit: Installation and
Customization Guide must be completed. This work normally is performed by an
enterprise’s Systems Programmer. To use the client workstation component, each
workstation component must be customized as described in that Guide.

What's new in Version 2.1

SCLM Administrator Toolkit Version 2.1 provides the following new or improved
functionality:

A Remote Migration Wizard is available from the workstation and assists you in
migrating workstation-based files into an SCLM project and placing them under
SCLM control. Once launched, the Remote Migration Wizard copies the remote
assets you selected into the target SCLM-managed library, updates an accounting
file, and displays a report that details the results of the migration.

Support for copybooks permits you to assign reusable elements of a project
definition to copybooks where they can be used by other projects.

When importing an SCLM project, the product discovers existing group/type
data sets and automatically adds them to the project.

Custom user macros can now be included within your project definition.

The Language Definition Wizard has been enhanced by replacing the free-form
editor with intelligent Wizard panels. In addition, context sensitive fields
throughout the Wizard maintain the consistency of the definition. The
information supplied using the Language Definition Wizard is more easily made
available to other Wizards for their use.

New VSAM tasks are distributed with the project. Additional default groups and
types have also been added.

A Quick Navigation facility has been added to the ISPF interface to improve the
speed and flexibility of navigating through the host components.

Performance for large projects is improved.

A set of ISPF panels assists you in downloading and installing the workstation
client.

At the workstation, in addition to using COPY and PASTE from a pop-up menu,
you may now use Ctrl+C and Ctrl+A, respectively, to copy selected text or all text
to the clipboard. Ctrl+V pastes the text to a place you select.

Two new preferences to assist you in understanding the size of your log files and
controlling their size have been provided. Information can be found in the
Software Configuration and Library Manager (SCLM) Administrator Toolkit:
Installation and Customization Guide.

Editing of the UNIX System Services shell scripts can be performed using a batch
job. You may, however, continue to perform manual customization if you prefer.

Other improvements have added to enhance the product’s ease of use and
performance.
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Part 1. Introduction

This part contains an overview of IBM Software Configuration and Library Manager
(SCLM) Administrator Toolkit.

© Copyright IBM Corp. 2003, 2005 1
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Chapter 1. About the SCLM Administrator Toolkit

IBM's SCLM is a program that provides software configuration and library
management for the z/OS platform. Using the SCLM Administrator Toolkit, you can
address the complexity of setting up an SCLM project initially, performing day-to-day
project maintenance, and managing access control from a workstation. It provides the
simplicity and functionality you need at an attractive cost.

Because SCLM Administrator Toolkit provides both a GUI and an ISPF interface, you
can work in the environment in which you're most comfortable. While SCLM
Administrator Toolkit functions run primarily in the foreground, the product
supports both batch and online execution for project creation, project cloning, and
VSAM file maintenance. You can choose immediate response when you require it, or
can defer processing to a more convenient time. You specify where these functions
are to run from the Window pull-down on the workstation by specifying Preferences
> SCLM Admin Toolkit. When using ISPF, you can specify this information by
selecting the Settings option on the SCLM Main Menu.

You can get started easily with SCLM Administrator Toolkit by invoking the SCLM
Project Wizard, either from a workstation or from an ISPF host session, to create a new
project or modify an existing one. When creating a new project, the fields in the
Project Wizard will be populated with default values. When modifying an existing
project, the fields contain that project’s defined values.

Using the Project Wizard, you can define the elements that comprise your project. As
you enter data into the Project Wizard, either at the workstation or using ISPF, that
data is saved at the host. Thus, at any time, you can choose to stop work before you
have fully defined the project. SCLM Administrator Toolkit saves your work so that
you can pick it up in a later session.

When defining a group using the workstation interface, you can drag and drop boxes
around your display, building a network of linked boxes much like an organization
chart. Each box represents an SCLM group. Once you have completed your
definition, SCLM Administrator Toolkit generates default authorization codes and
PROMOTE definitions, which you can modify if you so choose. A process to add or
modify groups is also available at the host using ISPF panels.

Using the Project Wizard, you can configure any user exits you may require,
including the Breeze user exits, if you have installed Breeze. You can add language
types, or you can modify them using the Language Definition Wizard.

Other functions provided by the SCLM Administrator Toolkit include:

¢ The ability to update and run your VSAM tasks and perform VSAM file
maintenance

¢ The ability to create architecture definitions manually or by importing them from
existing JCL or an existing Load Module, guided by the Architecture Definition
Wizard

¢ The ability to easily clone an existing project and, if you so desire, its data
You can update and manage SCLM projects that have not been created by SCLM
Administrator Toolkit, provided that these projects use simple SCLM macros and the

project definitions are not contained within macros as might be done, for example, to
support conditional project construction.

© Copyright IBM Corp. 2003, 2005 3



Support for Enhanced Access Control for SCLM Administration

Enhanced Access Control for SCLM is a program that enhances RACF security. The
SCLM Administrator Toolkit assists you in administering Enhanced Access Control
for SCLM by:

* Maintaining existing RACF Data Set Profiles, Enhanced Access Control for SCLM
Rules Files, Enhanced Access Control for SCLM Profile Access Rules, and
Enhanced Access Control for SCLM Applications

¢ Displaying a list of Enhanced Access Control for SCLM Violations

EAC administration tasks are performed from the workstation. For additional
information about the Enhanced Access Control for SCLM administration tasks
supported by SCLM Administrator Toolkit, see Part 3, “Administering EAC,” on page
87.

Hardware and software requirements

The sections that follow provide an overview of the hardware and software
requirements to run SCLM Administrator Toolkit. Current and complete information,
including any required APARs and PTFs is found in the SCLM Administrator Toolkit

Program Directory.

Note: When using the Linux and UNIX ports, SCLM Administrator Toolkit is an X-
Client Application. It may be sensitive to the X-Server being used if this is not the X-
Server located on the system.

Hardware requirements

Required hardware is any hardware environment that supports the required software
as described in “Software requirements”.

Software requirements

The software required to run SCLM Administrator Toolkit is as follows:
e XML Toolkit for z/OS V1.7

e J2REV14.2IBM]J9

e 7z/0SV1.4.2 or later

e IBM SMP/E for z/OS V3.2.0 or later

Note: IBM Eclipse SDK (IES) 3.0 or higher is required to run SCLM Administrator
Toolkit. If you do not already have IBM Eclipse SDK installed, it is installed as part of
the SCLM Administrator Toolkit installation process. Remote Systems Explorer (RSE)
must be at level 6.3.1.

4  IBM Software Configuration and Library Manager Administrator Toolkit: User’s Guide



Part 2. Administering SCLM

This part provides instructions for performing the tasks required to administer
SCLM. For information about administering IBM Enhanced Access Control for
SCLM, see Part 3, “Administering EAC,” on page 87.

If SCLM Administrator Toolkit has not yet been installed and configured for your site,
refer to the SCLM Administrator Toolkit Installation and Customization Guide for
information on installing the host and workstation components of the product and
performing the required customization.

Note: Before you can begin to use SCLM Administrator Toolkit, customization of the
host component as described in the SCLM Administrator Toolkit: Installation and
Customization Guide must be completed. This work normally is performed by an
enterprise’s systems programmer. To use the client workstation component, each
workstation component must be customized as described in that Guide.

© Copyright IBM Corp. 2003, 2005 5
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Chapter 2. Starting an SCLM Administrator Toolkit Session

In order to administer your existing SCLM projects or create a new project, follow the
directions below.

Important: If you are working with an existing project that was created or has been
migrated into SCLM Administrator Toolkit, you should be aware that all project
assembler source is regenerated. That is, the original source is rewritten, and all
parts of the project, including copybooks, must be in data sets to which you have
write access. If you do not want the original source to be modified, you should
clone the project before accessing it from SCLM Administrator Toolkit and work
with the clone. Using SCLM Administrator Toolkit in this way preserves the
original project code and also permits you to review the changes made by the
Toolkit.

From the workstation

Log onto SCLM Administrator Toolkit and follow the steps below. Do not start
multiple instances of SCLM Administrator Toolkit simultaneously from the same user
ID, since unpredictable results can occur.

1. Under Windows®, log onto the product from the Start menu: Start > Programs >
IBM SCLM Administrator Toolkit. Alternatively, open a DOS window to the
directory where you have installed SCLM Administrator Toolkit. At the
command prompt enter sclmadmintoolkit.bat.

2. In the UNIX® or Linux client environments, ensure you are running under the X
Window system and the DISPLAY environment variable is set. Change directories
to the eclipse directory by entering cd eclipse. From a command prompt, enter
sclmadmintoolkit.sh.

Note: Using sclmadmintoolkit.sh is the only recommended way to begin your
use of SCLM Administrator Toolkit. Do not execute Eclipse.

3. Enter your logon ID and password when prompted. The first time you use the
product, you should place a check next to Save ID on the logon pop-up. You may
optionally want to place a check next to Save Password, which makes it
unnecessary to reenter your password once you have logged onto the system. If
you have saved your ID or password and need to reset one or both:

a. From the Window pull-down, select Preferences > Remote Systems
>Passwords.

b. From the list that displays, select the system on which you want to add,
change, or remove password information and press OK.

© Copyright IBM Corp. 2003, 2005 7



4. The product typically will open in the SCLM Administration perspective. If the
product opens in other than the SCLM Administration perspective, switch to the
SCLM Administration Perspective by clicking the SCLM Administrator Toolkit
icon at the far left side of your workspace, or from the Window pull-down, click
Open Perspective > SCLM Admin Toolkit.

The SCLM Administrator Toolkit Icon:

3€

A pop-up menu may again request your logon ID and password for the host
system. When your logon has been accepted, your host session begins. You can
now create a project or modify an existing project.

5. In the Remote Systems Navigator, which can be seen from the Toolkit Perspective
main window, click on the name of the host where the SCLM project you want to
administer resides.

6. After your credentials have been validated and accepted, SCLM Administrator
Toolkit generates a list of existing SCLM projects including any alternate projects,
and displays these in the Navigator tree.

7. To create a new project, right-click on the SCLM Admin Toolkit connection in
the Navigator tree and select New > SCLM Project from the pop-up menu.

8. If you have previously defined a project or multiple projects, a list of these
existing projects displays in the Navigator tree. If you have defined a filter as
described in “Filtering objects in the Remote Systems Navigator tree”, this will be
a filtered list. Each existing project displays a blue box in front of its name. If the
project is an incomplete project, the blue box will have a broken line through it. If
the project is corrupt, the blue box will display a red X in it. To work with an
existing project, right-click that project in the Remote Systems View. Selecting
Open Project from the pop-up menu places you in the project wizard for that
project.

If you have selected an existing project to work with, SCLM Administrator Toolkit
displays the Reset SCLM Project dialog on which you can choose to reset your
SCLM project. Responding Yes to this dialog causes your project to be reparsed
from the project source code (that is, your XML source is regenerated).

9. You can delete or rebuild the project by right-clicking the project’s name and
selecting the appropriate choice from the pop-up menu. To perform other tasks
for this project, select that task from the list provided in the SCLM pull-down
menu Or pop-up menu.

Note: The SCLM pull-down menu is disabled if you do not have a project open in
the main window. If you are working with an open project, but that project has
never been successfully built or rebuilt, the pull-down menu is enabled, but you
can choose to rebuild or delete the project only. When you are working with a
project that has been successfully built or rebuilt, all SCLM pull-down menu
options will be available to you.

Filtering objects in the Remote Systems Navigator tree

You can filter the list of objects presented to you in the Navigator tree. The filters you
define are host-specific. That is, if you create a filter on host A, that filter will apply
only to host A and not to host B.

When you first install SCLM Administrator Toolkit, the project filter is set to an
asterisk (*). All projects appear in your Navigator tree. To change the filter, at any
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time you can right-click Project Filter in the Navigator Tree, then click Change in the
pop-up menu that displays. This causes SCLM Administrator Toolkit to display the
Change System Filter menu on which you can add or change project filters. You can
also right-click on a filter listed in the Filter Strings list box on this menu to see
additional options you can take against a specific filter.

Note: A project filter is case-sensitive.

About the workstation client menu bar

IBM Eclipse SDK (IES) 3.0 or higher is required to run SCLM Administrator Toolkit.
You may have several products installed that run under Eclipse that will use various
Eclipse or product-specific selections on the menu bar.

When you install the SCLM Administrator Toolkit client, selections specific to the
Toolkit are added to the Eclipse menu bar. When using SCLM Administrator Toolkit,
only the following menu bar selections apply:

¢ SCLM: The SCLM pull-down is added to the Eclipse menu bar. Using this SCLM
pull-down, you can rebuild, delete, or clone an existing project, or initiate the
Architecture Definition Wizard, the Migration Wizard, or the VSAM Maintenance
Wizard.

e  Window: You can use all of the available selections under the Eclipse Window
pull-down. The following selections are of particular interest when using SCLM
Administrator Toolkit:

— Open Perspective: You can specify Window > Open Perspective > SCLM
Administrator Toolkit to open the SCLM Administrator Toolkit perspective.

— Preferences: You can use Window > Preferences to set preferences for the
EAC Manager, Remote Systems, and SCLM Admin Toolkit. Information on
setting these preferences is found in the IBM SCLM Administrator Toolkit:
Installation and Customization Guide.

Other available Eclipse options should not be used to perform SCLM Administrator
Toolkit tasks. For instance, you should follow the directions in this manual to create a
new project. Do not use the File > New > Project pull-down available from the
Eclipse menu bar.

From an ISPF session

Log onto ISPF at the host. When you initially log onto TSO to use SCLM
Administrator Toolkit, your user profile should have been modified to specify an
adequate maximum size for your TSO region under RACF. Typically, this profile
modification will have been made for you by your site’s systems programmer when
setting up SCLM Administrator Toolkit. For the XML toolkit V1R7, your TSO
maximum region size should be 60000.

On the ISPF command line, type 10 to display the SCLM Main Menu. To begin to use
the SCLM Administrator Toolkit, type 8 on the ISPF command line to display the
SCLM Administrator Toolkit Project Administration Main Menu. From this menu,
you can enter one of the following options on the command line:

1 Settings: Permits you to set default values for the project.

2 Create: Permits you to create a new SCLM project. To create a new project,
enter the project name of up to 8 characters in length, and, if desired, an
alternate name, also of up to 8 characters, on the lines provided. Then enter 2
in the Options field.

3 List: Displays a list of SCLM projects. By placing the appropriate letter on the
line in front of a project, you can take one of the actions described in the next
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section, Actions you can take. You can filter the list of projects that SCLM
Administrator Toolkit displays by using an asterisk as a wild card as part of
the Project Name or Alternate Name field on the Main Menu.

If you have selected an existing project to work with, SCLM Administrator
Toolkit asks whether you want to reset your SCLM project. Responding Yes
causes your project to be reparsed from the project source code (that is, your
XML source is regenerated) and any settings that have been defined are
overwritten.

4 FTP: Permits you to download the workstation client component after you
have retrieved the product from the distribution medium to your host system.

X Exit: Saves your work and ends your SCLM Administrator Toolkit session.
You can also use PF3 to perform this action.

Notes:

1. If you are working in ISPF split screen mode, you may not work on the same
SCLM project in both SCLM Administrator Toolkit windows.

2. If you type OUTPUT on the Option line of an ISPF product panel, SCLM
Administrator Toolkit displays the output of the last script you have run. This
command may be useful to you when troubleshooting.

Actions you can take

10

Using SCLM Administrator Toolkit, you can:

Create a new project
SCLM Administrator Toolkit places you in the Project Wizard, with the
Wizard’s panels populated with SCLM Administrator Toolkit’s default
values. See Chapter 3, “Using the Project Wizard to Create or Modify a
Project,” on page 13.

Modify the project
SCLM Administrator Toolkit places you in the Project Wizard, with the
Wizard’s panels populated with the current project definition. See Chapter 3,
“Using the Project Wizard to Create or Modify a Project,” on page 13.

Create a Language Definition
SCLM Administrator Toolkit places you in the Language Definition Wizard.
See Chapter 6, “Using the Language Definition Wizard,” on page 47.

Delete the project
SCLM Administrator Toolkit determines whether the project or the project
and its associated data are to be deleted and takes appropriate action. See
Chapter 7, “Deleting a Project or Other SCLM Objects,” on page 67.

Clone the project
SCLM Administrator Toolkit places you in the project cloning view. See
Chapter 8, “Cloning an Existing Project,” on page 71.

Rebuild the project
SCLM Administrator Toolkit reassembles and relinks the project definition. If
the project has alternates, these will also be rebuilt. To rebuild a project,
complete the tasks to modify a project and select Rebuild.

Migrate assets into the project
SCLM Administrator Toolkit places you in the Migration Wizard to permit
the migration of host-based software assets into an SCLM-controlled project.
See Chapter 9, “Migrating Software Assets into your SCLM Project,” on page
73.
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Migrate workstation-based assets into the project
SCLM Administrator Toolkit places you in the Remote Migration Wizard to
permit the migration of workstation-based software assets into an SCLM-
controlled project. See Chapter 10, “Migrating Remote Software Assets into
your SCLM Project,” on page 75.

Perform VSAM file maintenance
SCLM Administrator Toolkit assists you to perform VSAM file maintenance.
SeeChapter 11, “Maintaining the Project’s VSAM Files,” on page 77.

Create an Architecture Definition
SCLM Administrator Toolkit places you in the Architecture Definition
Wizard. See Chapter 12, “Using the Architecture Definition Wizard,” on page
79.

Reparse the project
SCLM Administrator Toolkit regenerates the XML code associated with this
project.

Viewing a log of commands executed at the host

From the workstation, you can use the Tasks list to review error and warning
conditions as well as logs of the commands that have executed at the host system.
The Tasks list is displayed at the client workstation at the bottom of the Main window,
under a tab called Tasks. Each entry provides:

* Anicon indicating whether this is an error, a warning, or an informational entry.
Any errors or warnings appear in the Tasks View ahead of any informational
entries.

* The date and time when the entry was created, as well as the name of the
command that was executing

¢ The name of the log file, its folder, and the location of the log entry within the log

You can use the Tasks list to navigate to each entry in the list, either by double-clicking
the entry or by right-clicking the entry and choosing Go To from the pop-up menu
that is displayed. If the log is already open in an editor window, clicking on the entry
will cause the editor to navigate to the entry’s location in the log.

To delete an entry from the log, select it from the SCLM Tasks View, then press the
Delete key. Alternatively, right-click the entry and select Delete from the pop-up
menu. This causes the selected entry to be removed from the Tasks View and its
corresponding text to be deleted.

Two preferences are provided for you to control the size of your log files. For
information about these preferences, see the Software Configuration and Library
Manager (SCLM) Administrator Toolkit: Installation and Customization Guide.

By default the view displays up to 100 visible items. You can change this value by
clicking on the Filter icon at the top right of the line that contains the Tasks tab. On the
pop-up Filters dialog that is displayed, change the value for the field Limit Visible
Items to:

The Filter icon:

=

—+I
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Chapter 3. Using the Project Wizard to Create or Modify a
Project

This chapter will help you get started using the SCLM Administrator Toolkit Project
Wizard to create or modify a project. Before starting an SCLM Administrator Toolkit
session from the workstation client or from ISPF, be sure you have completed the
steps to install and customize the product as documented in the IBM Software
Configuration and Library Manager (SCLM) Administrator Toolkit: Installation and
Customization Guide.

From the workstation

If you are using the workstation interface:

1. Start your workstation session by clicking Start > All Programs > IBM SCLM
Administrator Toolkit to open the product.

Click the host on which you want to perform administration tasks
Enter your z/OS user ID and password for that host
After your credentials have been validated and accepted:

* To create a new project, right-click on the SCLM Admin Toolkit connection in
the Navigator tree in the leftmost pane and select New>Project from the pop-
up menu.

* To modify an existing project, click its name in the Remote Systems Explorer
view. SCLM Administrator Toolkit retrieves the project’s settings from the
host.

From an ISPF session

If you are using ISPF, you can enter option 10, followed by option 8, on successive
ISPF panel Command lines. This displays to you, in order:

e The SCLM Main Menu
e The SCLM Administrator Toolkit Main Menu

To create a new project, on the SCLM Administrator Toolkit Main Menu, type option 2
on the Command line and press Enter. SCLM Administrator Toolkit places you in the
first panel of the Project Wizard.

To modify an existing project, type option 3 on the Command line and press Enter.
SCLM Administrator Toolkit generates and displays a list of existing SCLM projects
from which you can select the one to modify.

To shortcut this process, type option 10.8.2 or option 10.8.3, respectively, on the ISPF
Command line and press Enter to create or modify a project.

As you enter data into the Wizard's panels, the values you enter will be saved at the
host system, so that if you choose to end a session before completing your work, any
definitions or modifications are saved and are available to you when you resume your
work.
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Working with the Project Wizard

14

The Project Wizard guides you through the steps of defining your SCLM project. The
chapters that follow describe using the Wizard from the workstation (Chapter 4,
“Using the Project Wizard from the Workstation to Create or Modify a Project,” on
page 15) or from an ISPF session (Chapter 5, “Using the Project Wizard from an ISPF
Session to Create or Modify a Project,” on page 31).

You can perform some steps of the Wizard using the workstation and other steps of
the Wizard using ISPF at the host system; but if you create or modify a project using
the SCLM Administrator Toolkit and subsequently modify that project outside of the
Toolkit, you cannot automatically merge the changes.

However, if the latest version of the project is the one you worked on outside of the
Toolkit, you can capture that version as the Toolkit version by reparsing the project the
next time you open SCLM Administrator Toolkit and before you make additional
changes to the project using the Toolkit. If you are using the workstation client, you
will be advised that the Toolkit version is not the most current version of the project.
You will be asked whether you want to reset the project, to which you should respond
Yes.

Alternatively, you can save the changes you made outside of the Toolkit by manually
updating the Toolkit version before you next rebuild it.
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Chapter 4. Using the Project Wizard from the Workstation to
Create or Modify a Project

This chapter describes the use of the Project Wizard when working at a workstation
client. For information about using the Project Wizard from an ISPF session, see
Chapter 5, “Using the Project Wizard from an ISPF Session to Create or Modify a
Project,” on page 31.

Navigating through the workstation interface

This chapter assumes that you have logged onto SCLM Administrator Toolkit as
described in Chapter 3, “Using the Project Wizard to Create or Modify a Project,” on
page 13. At the start of a session, the Project Wizard's fields are populated by the
SCLM Administrator Toolkit's default values, or, if you are modifying an existing
project, that project’s previously-defined values. By selecting the appropriate tabs at
the bottom of each Project Wizard page, you can move between the various pages of
the Wizard until you have completed your project definition or modification. The
pages you use are the same for both project creation and project modification. As you
define various aspects of your project, you can review the associated XML source
code by clicking the Source tab, found at the bottom of each Project Wizard page. You
must not edit this XML source outside of SCLM Administrator Toolkit.

Creating a new SCLM project -- the work flow

Once you have started SCLM Administrator Toolkit, you will perform the following
tasks to create a new SCLM project:

¢ Right-click SCLM Admin Toolkit in the Navigator tree and select New SCLM
Project.

¢ During the customization of your client workstation, you may have defined
default Types for your profile using the SCLM Administrator Toolkit Preferences.
To review the way in which this was accomplished, see “Defining default Types
and setting their DCB values” on page 16.

* Name the project and define the project management working data sets; see
“Defining default data sets for the project” on page 17 and “Defining project
settings” on page 18.

* Define your control data sets; see “Defining control data sets” on page 19.

e Select the Types you want to include in your project; see “Adding or removing
Types” on page 21.

* Optionally, create authorization groups and authorization codes; see “Adding or
removing authorization groups and authorization codes” on page 23.

¢ Define groups for your project and the promotion hierarchy; see “Adding or
deleting groups” on page 23.

* Select the group/Type combinations to be allocated; see “Specifying group/Type
allocations” on page 24.

* Define or select language definitions; Chapter 6, “Using the Language Definition
Wizard,” on page 47.

* Select any user exits you will require; see “Specifying user exit information” on
page 26.
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¢ Save and build your project; see “Building or rebuilding your project” on page 29.

At any time during the project creation or editing process, you may choose to save
your project or quit your work. To save at any time, click the Save icon. When you
want to quit work, SCLM Administrator Toolkit displays the Save Resource dialog, on
which you can choose whether or not to save your changes before closing the session.

If you try to save a project and receive a message indicating that the Save failed at the
host, you can correct the problem and then click the Save icon again. One cause of
such a message is an instance where you may have worked on the project at the host
system and did not close the project before starting to work at the workstation. In this
case, closing the project on the host system should allow you to save your work from
the workstation.

When you build or rebuild a project and the save fails on the host, SCLM
Administrator Toolkit discontinues the build or rebuild.

Note: A Preferences page in Remote Systems Explorer permits you to control file
cache size and clear the cache. If you do so while you have an open project, you will
impact your ability to correctly save your project. Thus, you must not clear the cache
while you have projects open in SCLM Administrator Toolkit.

Working with an existing project

Once you have started to define a project, its name appears in the project list in the
Remote Systems Navigator tree, Projects you have started to define can be classified
as complete, complete and parsed, incomplete, or corrupt. The state of a project is
reflected in the state of the blue icon that precedes the project’s name in the Navigator
tree. A project can be:

e Complete

* Incomplete -- some additional work is required to complete this project definition.
e Corrupted -- Some of the project definitions contain errors.

e Parsed -- if the XML code for a project has been generated.

To work with an existing project, click its name in the Navigator tree. The Project
Wizard displays, with fields populated by the values you have previously entered.

Defining default Types and setting their DCB values

SCLM Administrator Toolkit provides a number of fully-defined default Types which
you can choose to include in your project as is. You can use the Default Types
Preference page to modify the Type definition for these types or to define new Types.
You may already have worked with the product’s default Types when customizing
the workstation client. To access the Default Types Preference page, expand the SCLM
Admin Toolkit item in the Preferences Navigator Tree by selecting the following from
the Window pull-down: Window > Preferences > SCLM Admin Toolkit > Default
Types Preference Page. To add a default Type to your project, on the Preferences
page, select the Type to be added from the list of default Types and click the Add
button. To edit an existing default Type, click the Edit button. SCLM Administrator
Toolkit displays the Type Dialog on which you can specify or edit the selected Type
information:

1. A name of up to 8 characters and a description for the Type. (If you are editing an
existing Type, its name is filled in this field.)

2. The average number of records contained in the top-level data set of this Type.
This mandatory value, together with the number of members value and the DCB,
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is used to calculate the space required for the PDS or PDS-E at the top of the
promotion tree.

The number of members contained in the top-level Type data set. This mandatory
value, together with the average number of records value and the DCB, is used to
calculate the space required for the PDS or PDS-E at the top of the promotion tree.

An extended Type name of up to 8 characters that can be used as an alternate
Type if it is necessary to resolve include dependencies.

Reuse Days, which specifies the number of days a package can be reused. Reuse
Days should be specified when the Packfile checkbox is selected.

If a Type has been defined as using package backup:

1.

Click the Package Backup check box to specify that this Type of file is to be backed
up during a promote.

Click the Backout ISAPack check box to specify that this architecture definition
will be used to drive the packages that are permitted to be backed out. This flag
can be specified only for architecture definition (ARCHDEF) Types.

Click the Packfile box to specify that this Type is to hold the package detail files.

Note: Backup and Packfile are mutually exclusive.

Specify the following default DCB information for the Type:

The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, VBM,
or U.

The default DCB block size. Valid value is an integer from 32 — 32760
The default DCB logical record length. Valid value is an integer from 32 — 32756.
Note: When you add a new Type to your project, you should ensure that:

— If RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0,
and must be less than or equal to 32760.

— 1f RECFEM=VByx, LRECL must not be equal to 0. BLKSIZE must be equal to 0,
or must be greater than LRECL + 4 and less than or equal to 32760.

— 1f RECEM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0,
or must be an exact multiple of LRECL and less than or equal to 32760.

When you have completed your entries on this page, click OK. At any time, you can
return to this page to modify your entries, to remove a default Type from your profile,
or to restore the product’s default settings.

Defining default data sets for the project

When you right-click SCLM Admin Toolkit and select New Project, SCLM
Administrator Toolkit presents you with the Default Data Sets dialog. On this panel,
you can specify:

The format of your project’s data sets, either PDS or PDS-E. PDS-E is the default.
When you are modifying a project, the value you enter here will affect only newly
created library data sets. Existing data sets will remain unchanged.

Fully qualified data set names for each Type of data set you want to include in
your project. Click Browse to display the default data sets. You can change their
names if you wish. The project definition data sets (projectname.projdefs.”) contain
administration JCL, PROCs, CLISTs, SOURCE, OB]J, LIST, LINKLIST, and Work
files. Typically, the format for the data set name is projname.groupname.typename,
where projname is the name of your project, groupname is a name you will specify
for this data set group, and typename is the name of the type of data this data set
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will contain. The associated SCLM variables are @@FLMPR], @@FLMGRP, and
@@FLMTYP, respectively.

Fully qualified data set names for each SYSLIB data set you want to include in
your project. The SYSLIB data sets hold standard IBM macros as well as any
language definitions you may create. You must define at least one SYSLIB data
set. Clicking Browse displays the data set’s name. This name is set to the default
value, which you can change if you wish.

Note: When entering the SYSLIB data list, the very first SYSLIB must be the
source DSN. For example, if my main project source is

<hilev> PROJDEFS.SOURCE, then my SYSLIB list must have
<hilev>PROJDEFS.SOURCE first, followed by whatever other libraries are
needed for the project.

Defining project settings

On the Wizard's Project Settings page, the values you are asked to enter include:

The name, of up to 8 characters in length, of the new project. If this is an existing
project, its name appears in the Project Name or Alternate Name text boxes.

Whether it is an alternate project, and, if so, the alternate project’'s name. The
alternate project name may not exceed 8 characters in length.

The DASD Unit where the project’s data sets will reside. The default is
SYSALLDA.

The Virtual Input/Output (VIO) unit to be used to store temporary data sets. The
default is VIO.

The maximum number of records permitted for VIO allocation. The default is
5000.

The maximum number of lines per page for all SCLM reports. The minimum
value is 60.

Whether translator option overrides are allowed. Check the box to specify that
developers can override translator options for any of the languages by using the
PARM statement in the architecture members. If you do not permit translator
overrides, SCLM uses only those translator options you specify in the language
definition for the translators. .

Whether VSAM record level sharing (RLS) is available. Check the box to specify
that RLS can be used.

If your project will be translated to a language other than English, you will be able to
specify these additional settings parameters:

EN

DE

ES

P

You may select one of the following values from the pull-down box for
LANGUAGE=

(the default) Messages and assembler listing headings appear in mixed upper case and
lower case English

Messages appear in German. Assembler listing headings are printed in
mixed upper and lower case English.

Messages appear in Spanish. Assembler listing headings are printed in
mixed upper and lower case English.

Messages appear in Japanese. Assembler listing headings are printed in
upper case English.
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* You may select one of the following values from the pull-down box for

CODEPAGE=
1140 (the USA, Canada, Netherlands, Portugal, Brazil, Australia, New Zealand
default)
1141 Austria, Germany
1142 Denmark, Norway
1143 Finland, Sweden
1144 Italy
1145 Spain, Latin America (Spanish)
1146 United Kingdom
1147 France
1148 International 1
939 Japanese
933 Korean
935 Simplified Chinese
937 Traditional Chinese

¢ If your project will contain double-byte characters, select DBCS=Y. The default is
DBCS=N.

To define or edit the default data set information for the project, click the Default
Data Sets button.

Recommendations and suggestions

You will want to complete the project definition tasks above before you migrate assets
into your project and create architecture definitions for your project. Additionally,
you will want to migrate assets into your project prior to creating architecture
definitions.

Defining control data sets

Use the control data sets page to assign fully-qualified data set names to the project's
control data sets. You can also use this page to specify whether your project will have
alternate control data sets. If you want alternate control data sets, click the
appropriate radio button to indicate that the data set names you are providing are
alternate control data set names and assign an identifier of up to 8 characters for the
alternate control datasets. Then click Add to display the Control Data Sets dialog.

Alternate control data sets provide alternate control for individual groups. Specifying
alternate control data sets provides information used by the SCLM FLMALTC macro
to override certain options on the FLMCNTRL macro for specific groups. For
example, each group can control independently how many versions are saved, where
to keep its accounting data, etc., by using alternate control data sets. Specifications
apply only to the groups using them. You can specify multiple alternate control data
sets. Their specification is optional.

On the Control Data Sets dialog, assign fully qualified names for the primary or
alternate control data sets. Also, specify the following information:
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* In the optional Data Set Name text field, specify the data set naming convention
for the project

¢ In the text boxes provided, specify a fully-qualified name for each control data set.

¢ Select the allocation units for the control data sets. In the boxes provided, specify
the primary and secondary allocation in terms of the selected allocation unit. The
default for the primary allocation is 2 cylinders and for the secondary allocation,
4 cylinders.

When you have completed your set of control data set or alternate control data set
definitions, click OK to add the set to the list of any previously-defined sets that
appears in the Control Data Sets Information list box on the Control Data Sets page.

To remove a set of control data sets from this list box, highlight the set, then click
Remove. To edit a set of control data sets, highlight the set’s name in the list box, then
click Edit.

Each project must have at least one primary accounting data set. This data set contains
information about application programs in the project. The secondary accounting
data set is optional and is used as a backup for your primary accounting data set. The
data set name you specify must be the same as the name of the VSAM cluster you
want to use.

The export accounting data set is optional unless you plan to use the import and
export functions. The data set name you specify must be the same as the name of the
VSAM cluster you want to use. It must not have the same name as either the primary
or secondary accounting data set.

Audit control data sets contain information about changes to SCLM-controlled
members that are located in groups being audited. Audit control data sets must be
created before you can use SCLM's audit function. The high level qualifier of the audit
control data sets must be an entry in a VSAM catalog. If you will specify on the
Group/Type Dialog that auditing is to be used, you must have at least one primary
audit control data set. The secondary audit control data set is optional and is used as a
backup for your primary audit data set. When specifying the parameters for the
primary and secondary audit control data sets, you may not use SCLM variables; that
is @@FLM***.

The Version PDS name identifies the partitioned data set where version data and
SCLM variables are stored. If you will specify on the Group/Type Dialog that
versioning is to be used, you must specify a value in the Version PDS Name field on
this dialog. This dialog also permits you to specify the number of versions to keep in
the version partitioned data set. If you specify 0, all versions associated with a
member will be retained. If you specify a value of 2 or more, each time a member is
saved or promoted, the latest copy of the version is stored and the earliest copy is
discarded. Any audit records that were associated with the version are retained but
will no longer indicate that a version of the member exists. If you specify a value of 2
or more, allocate a separate VERPDS for each group that has versioning enabled. This
value may not be specified for alternate control data sets. The value in this field can
be overridden by the value you may specify in the Number of Versions field on the
Group/Type dialog.

Some additional considerations and restrictions

When defining the project’s control data sets using the macros FLMCNTRL (primary
control data sets) and FLMALTC (alternate control data sets), ensure that:

¢ Each occurrence of an FLMALTC macro has at least one ALTC parameter on an
FLMGROUP (group definition) macro pointing to it.
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¢ FLMCNTRL and FLMALTC macros do not use SCLM variables when specifying
the ACCT (primary accounting data set) and ACCT2 (secondary accounting data
set) parameters.

¢ FLMCNTRL and FLMALTC macros do not use SCLM variables when specifying
the VERS (primary versioning data set) and VERS2 (secondary versioning data
set) parameters.

e FLMCNTRL and FLMALTC macros use only @@FLMPR], @@FLMGRP, and
@@FLMTYP when specifying the DSNAME parameter. If the DSNAME
parameter is specified, it must include @@FLMTYP.

e FLMCNTRL and FLMALTC macros use only @@FLMPR], @@FLMGRP, and
@@FLMUID when specifying the EXPACCT parameter.

¢ FLMCNTRL and FLMALTC macros use only @@FLMPR], @@FLMGRP,
@@FLMTYP, and @@FLMDSN when specifying the VERPDS parameter. If
@@FLMDSN is used, it must appear in the first 8 characters of the specification.

Adding or removing Types

The Types page permits you to specify the Types that will be included in your project,
and define the characteristics of those Types. Typically, a Type names the kind of data
a given data set contains—for example, LOAD, SOURCE, or JCL. Type is normally
the third qualifier in a project library’s fully-qualified data set name. Your project
must contain at least one Type. Otherwise, it cannot be built. Additionally, if you
have specified a Type at a lower level of the hierarchy, that Type must persist all the
way to the top of the hierarchy.

On this page you can add a Type or multiple Types to your list of default Types; or
add a Type or multiple Types to your project, as follows:

¢ To move a default Type into your project, click its name in the Default Types list
box and then the right-pointing arrow (>) to move it to the Selected Types list.

* To move all of the Types from the Default Types list box to the Selected Types list,
click the double arrow (>>).

¢ To move multiple types from the Default Types list box to the Selected Types list
box, hold down the Ctrl key to select the Types you want to move, then click the
right-pointing arrow (>).

You can remove a Type or multiple Types from your project as follows:

* Toremove a Type from your project, select its name in the Selected Types list box
and click the left-pointing arrow (<).

¢ Toremove multiple types from the Selected Types list box to the Default Types list
box, hold down the Ctrl key to select the Types you want to move, then click the
left-pointing arrow (<)

¢ Toremove all of the Selected Types, click the double left-pointing arrow (<<).

When you decide to remove a Type or Types from your project:

e The Wizard asks you to confirm the removal of the Type. If you select the No
button, no action is taken.

e If you select the Yes button, then the Wizard asks whether you want to also delete
the data associated with this Type. If you select No, then only the Type is deleted.
If you select Yes, then the Type and any associated data sets for this Type are
deleted.
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Note that this behavior differs when you take similar actions using the ISPF
interface. When using the ISPF interface at the host, you are asked to confirm the
deletion of the object and the deletion of associated data only from the Group/Type
panel.

To define a new Type, click the Add button. Or, to modify an existing Type, you can
define or edit its characteristics by clicking its name and the Edit button. Either of
these actions displays the Types Dialog.

In the Types Dialog, specify or edit:

1. A name of up to 8 characters and a description for the Type. (If you are editing an
existing Type, its name is filled in this field.)

Optionally, a description of the Type

An extended Type name of up to 8 characters that can be used as an alternate
Type if it is necessary to resolve include dependencies.

4. Data set allocation information. You can specify the allocation units to be used,
and the primary and secondary quantity of the allocation units to be allocated.
Alternatively, you can have SCLM Administrator Toolkit calculate the data set
allocation required by placing a check in the appropriate box and specifying the
following:

¢ The average number of records contained in the top-level data set of this
Type. This mandatory value, together with the number of members value and
the DCB, is used to calculate the space required for the PDS or PDS-E at the
top of the promotion tree.

¢ The number of members contained in the top-level Type data set. This
mandatory value, together with the average number of records value and the
DCB, is used to calculate the space required for the PDS or PDS-E at the top of
the promotion tree.

5. Reuse Days, which specifies the number of days a package can be reused. Reuse
Days should be specified when the Packfile checkbox is selected.
If a Type has been defined as using package backup:

1. Click the Package Backup check box to specify that this Type of file is to be backed
up during a promote.

2. Click the Backout ISAPack check box to specify that this architecture definition
will be used to drive the packages that are permitted to be backed out. This flag
can be specified only for architecture definition (ARCHDEF) Types.

3. Click the Packfile box to specify that this Type is to hold the package detail files.

Note: Backup and Packfile are mutually exclusive.

Specify the following default DCB information for the Type:

e The default DCB record format. Valid formats are FB, FBA, VB, VBA, FBM, VBM,
or U.

® The default DCB block size. Valid value is an integer from 32 — 32760
® The default DCB logical record length. Valid value is an integer from 32 — 32756.
Note: When you add a new Type to your project, you should ensure that:

— 1f RECFM=U, LRECL must be equal to 0. BLKSIZE must not be equal to 0,
and must be less than or equal to 32760.

— 1f RECEM=VByx, LRECL must not be equal to 0. BLKSIZE must be equal to 0,
or must be greater than LRECL + 4 and less than or equal to 32760.

— If RECFM=FBx, LRECL must not be equal to 0. BLKSIZE must be equal to 0,
or must be an exact multiple of LRECL and less than or equal to 32760.
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Adding or removing authorization groups and authorization codes

To access the Authorizations Page, select the Authorizations tab from the bottom of a
page in the Project Wizard. You can use the Authorizations page to:

* Add or remove an authorization group or authorization code

® Assign an authorization code or codes to an authorization group or remove them
from the group

¢ View the previously defined authorization codes belonging to a given
authorization group

To add an authorization group or authorization code , enter its name, of up to 8
characters in length, in the appropriate text box at the top of the page and press the
Add button. If you have entered a new authorization code after an authorization
group has been defined on this page, it is assumed that the new authorization code
belongs to (is a dependent of) the authorization group whose name is currently
highlighted in the Authorization Groups list box.

To remove an authorization group or authorization code from the project, click its
name in the appropriate list box. Then click the Remove button. If you remove an
authorization group that has dependent authorization codes, those authorization
codes are also removed from the project.

To view all of the previously-defined authorization codes you have assigned to a
given authorization group, click that group in the Authorization Groups list box. All
of the authorization codes you have assigned to this group are displayed in the
Authorization Codes list box.

You must ensure that there are no loops when you define your authorization groups
and authorization codes. An example of what to avoid is the case where
authorization group AGRP1 contains authorization codes A, B, C, AGRP2, and
authorization group AGRP2 contains authorization codes A, B, D, AGRP1. This
specification is invalid.

Adding or deleting groups

Selecting the Group tab from the bottom of a page in the Project Wizard displays the
Groups page.

A group is equivalent to a node within a project hierarchy. For example, in a code
development project, Development, Test, and Ship can each be considered a group.
Data sets having the same midlevel qualifier in their fully qualified names can be
considered as belonging to the same group. Rules that govern your ability to move or
copy data between groups are specified by the authorization codes associated with a
group. Your project must contain at least one group. Otherwise, it cannot be built.

All groups except the top-most group in a project hierarchy must promote to another
group. All groups specified as Development must be specified as a key group. The
topmost group in a hierarchy must also be specified as a key group.

When defining promotion from group to group, there can be no loops. Thus, for
example, you cannot define a promote sequence that has group A promoting to group
B which in turn promotes back to group A. Doing so will cause a project build or
rebuild to fail.

To add a new group, on the Groups page, enter a name for the group of up to 8

characters. The name of the group must be unique for this project and must be valid
for a data set qualifier. Then click Add Group to add this to your project.
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SCLM Administrator Toolkit now displays a box, the name of which is the name of
the group you specified. You can continue to add boxes by naming them and clicking
Add Group, then dragging and dropping them around the blank area of the page.
Each box represents an SCLM group. As you place each box on the blank panel or
‘canvas', you can link each new box to an existing box or boxes, in the same way as
you might create an organization chart in a drawing package. If you should drag a
group off the visible area of the panel, you can use the panel’s scroll bars to view it.

To link a group to its promote group, first right-click the group, then right-click the
group to which members of the first group will be promoted. SCLM Administrator
Toolkit inserts a line showing the relationship between the groups.

To remove a group from your project, click the group, then Remove.

® The Wizard asks you to confirm the deletion of the group. If you select the No
button, no action is taken.

¢ If you select the Yes button, then the Wizard asks whether you want to also delete
the data associated with this group. If you select No, then only the group is
deleted. If you select Yes, then the group and any associated data sets for this
group are deleted.

Note that this behavior differs when you take similar actions using the ISPF
interface. When using the ISPF interface at the host, you are asked to confirm the
deletion of the object and the deletion of associated data only from the Group/Type
panel.

To define the attributes for a group, double-click it to display the Group Dialog. On
this dialog, for the group you have chosen:

1. Select the name of the group to which members of this group will be promoted
from the drop down box provided.

2. Specify aname of up to 8 characters for the data set that defines an alternate set of
control options to be used for this group.

3. Specify a name of up to 8 characters for the Package Backup Group. You must
have defined package backup for the current group in order to specify this option.

4. Check the Member Restore check box to specify that, for this backup group,
member restore is in effect. If you check Member Restore, SCLM will restore
individual members rather than an entire package. You must have defined
package backup for the current group in order to specify this option.

5. Check the Key check box to specify that the group you are defining is a key group.
If you identify a group as a key group, data moved to this group is erased from
the group from which it was promoted. If you do not identify this group as a key
group, then data moved to this group is copied from the group from which it was
promoted.

6. Select the authorization codes to be associated with this group by moving them
from the Available list to the Selected list.

Specifying group/Type allocations

Use the Group/Type page to select from the group/Type combinations in your
project, those for which you want to change existing allocations. To move a
group/Type to the Group/Type Allocations list box, click its name and then the right-
pointing arrow (>). To override the default allocations for all of the group/Type
combinations, click the right-pointing double arrow (>>).

To remove a group/Type combination from the Group/Type Allocations list, select its
name and the left-pointing arrow (<). To remove all of the combinations from the
Group/Type Allocations list, click the double left-pointing arrow (<<).
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® The Project Wizard asks you to confirm the removal of a group/Type from your
project. If you select the No button, no action is taken.

¢ If you select the Yes button, then the Wizard asks whether you want to also delete
the data associated with this group/Type. If you select No, then only the
group/Type is deleted. If you select Yes, then the group/Type combination and
any associated data sets are deleted.

Note that this behavior differs when you take similar actions using the ISPF
interface. When using the ISPF interface at the host, you are asked to confirm the
deletion of the object and the deletion of associated data only from the Group/Type
panel and you are not permitted the opportunity to confirm deletion from either the
Types panel or Groups panel.

Place a check in the Sort by Type checkbox to reorder the group/Type combinations in
both list boxes by Type.

Once a group/Type combination is in the Allocations list, to override its defaults, click
its name, then the Edit button. SCLM Administrator Toolkit displays the Group/Type
Dialog.

On the Group/Type Dialog, the text box at the top of the page displays the name of
the group/Type combination for which you are overriding default allocation values.
On the dialog:

1. Specify the allocation units, selecting from those that are listed in the drop-down
box.

Specify the number of primary and secondary allocation units.
Specify the record format, block size, and logical record length.
Specify the storage class, data class, management class, and volume label.

e The storage class is a collection of storage attributes that identify performance
goals and availability requirements, defined by the storage administrator, and
used to select a device that can meet those goals and requirements. When a
storage administrator assigns a storage class to a new data set, the data set
becomes an SMS-managed data set.

e The data class is an SMS class that contains the attributes related to the
allocation of a data set, such as LRECL, RECFM, and SPACE.

¢ The management class is a named collection of management attributes
describing the retention and backup characteristics for a group of data sets.

* The volume label identifies storage space on DASD, tape, or optical devices.

5. Place a check mark in the appropriate box to specify whether auditing is active for
this group/Type. If you specify that auditing is active, you must have specified a
name for the audit data set on the Control Data Sets dialog. If you specified that
auditing is active, you can now define information for version data sets, including

e Whether check sum is in effect

e The number of versions to be retained. When the number you have specified
is reached, the latest version is kept and the earliest version is discarded. The
value in this field will override the value you specified in the Versions to
Retain field on the Control Data Sets dialog.

¢ The sequence number type which may be STANDARD, STD, COBOL, or
NONE. NONE is the default.

If you will use versioning, you must have specified a Version PDS Name on the
Control Data Sets dialog.
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Adding or deleting language definitions

To add a language definition to or delete one from your project, use the Language
Definition Wizard. For information, see Chapter 6, “Using the Language Definition
Wizard,” on page 47, the section titled “From the workstation” on page 47.

Specifying user exit information

Use the User Exits page to perform the following tasks:

1. To specify that the Breeze product is installed and you wish to configure Breeze
User Exits, place a check in the appropriate check box. If you place a check in the
check box, the name of the data set containing the Breeze User Exits is displayed
for you. You can change this information by overtyping it.

2. Select from the list of Default User Exits those exits that will be included in your
project. To select a single exit, click its name and then click the single arrow (>) to
move it to the Selected User Exits list box. To select all of the Default exits, simply
click the double arrow (>>). You can select multiple Default Exits by holding
down the Ctrl key and clicking only those exits you want to move to the Selected
list box, then clicking the single arrow (>).

3. Once you have moved all of the exits you want to work with to the Selected User
Exits list box, you can configure them by first clicking the exit's name and then the
Edit button. Doing so causes SCLM Administrator Toolkit to display the User
Exits dialog. Using the User Exits dialog, you can configure an individual exit by

a. Specifying the module name where the exit code is stored
b. Specifying the Load Data Set name that contains the module

c. Selecting the Exit invocation method—linked, attached, invoked by TSO, or
called through ISPF services

d. Entering the option list to be passed to the user exit routine. You can specify
a maximum of 255 characters, including delimiters, for the options. Enclose
the option string in parentheses or single quotes.

To remove an exit from the Selected list box, click its name, then the left-pointing
single arrow (<). Move all of the exits out of the Selected box by clicking the left-
pointing double arrow (<<). You can remove multiple exits by holding down the Ctrl
key and clicking only those exits you want to remove from the Selected list box, then
clicking the left-pointing single arrow (<).

Support for user macros, copybooks, and comments

When you use SCLM Administrator Toolkit to open an SCLM project that was created
outside of the Toolkit, the source code is parsed to generate an XML representation
(project definition markup language or PDML) of the project. The parsing process
maintains the original source structure for copybooks and user macros. When the
project is rebuilt using SCLM Administrator Toolkit, the original source structure is
reconstituted. The modifications made within SCLM Administrator Toolkit will be
made in the appropriate location within these source files.

User macros

User macros are custom macros that have been developed by personnel such as SCLM
administrators or programmers. They are designed to override parameters in the
various FLMxxxxx macros or to feed information to them. When a user macro is
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associated with an FLMxxxxx macro, the user macro’s parameters replace specific
FLMxxxxx parameters when the SCLM project definition source is assembled.

If your project contains user macros that are present in the PDML, an additional tab,
User Macros, appears in the list of tabs that is displayed at the bottom of each SCLM
Suite Administrator Workbench panel. Clicking on this tab displays a list of the top-
level user macros that appear in the PDML. Using the appropriate buttons, you can
Edit a user macro that exists in the project or you can Add or Remove a user macro
from the project. Note that you can add a user macro to a project only when that same
user macro is already associated with the project. Only existing user macros, that is,
macros that have already been parsed, may be added to the project or edited.

Selecting a user macro from the list on the User Macros panel and pressing the
Remove button removes the selected user macro from your project.

Pressing the Add or Edit button displays the User Macro Wizard. On the first
wizard panel, Add User Macro, a list of user macros that are available to be added to
a project or edited is displayed.

Pressing the Next button displays a dialog that permits you to update parameter
values for the macro you selected. The User Macro Parameters dialog will always
display the name of the user macro and the names of the data set and member that
contain the user macro. Other fields that appear on the panel are variable depending
on the values that already exist in the user macro. Note that you can edit only the top-
level user macro. FLMxxxxx macros that are children of a user macro may be edited
only by editing the top-level user macro. When you have completed your work, press
Finish to complete the addition or edit of the selected macro.

You can see the effects of changes to a user macro by reparsing your project.
Refactoring a project and creating a copybook

Building or rebuilding your project results in the creation of Assembler source. That
source may contain macros and copy statements that you want to expand, review, or
save offline from the project in a specified dataset and member. Refactoring your
built Assembler source gives you the opportunity to do so.

A tab labeled Refactor appears in the list of tabs that is displayed at the bottom of
each SCLM Administrator Toolkit panel. Clicking on this tab results in the project
Assembler source being displayed in an LPEX Editor window.

Note: If text appears in an LPEX Editor window, you can edit that text at any time.
In this window, you can select one or more pieces of text using your mouse. If the text
you selected contains either a macro or a COPY statement, SCLM Administrator

Toolkit permits you to take some actions, depending on the content of the selected
text. Note the following;:

*  You can select multiple macros and COPY statements in the same execution
*  You cannot select the macros FLMABEG and FLMAEND

e If the first line of your selection is a comment, the selection is expanded to include
the next macro in the text

Working with a copybook

You can assign reusable elements of a project definition to copybooks for use in other
projects. If the source you selected contains a COPY statement, the FORWARD
button in your SCLM Administrator Toolkit window becomes active. Use the
FORWARD button to drill down on the selected COPY statement. Note that, even if
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your selection contains more than one COPY statement, you can drill down on only
one such statement at a time.

Clicking FORWARD expands the copybook to insert the copybook’s contents within
the refactoring window. If you have nested COPY statements, you can expand these,
one at a time, using FORWARD. As you drill down, pressing the BACK button takes
you back one level in your nesting structure. Note that REBUILD and UNDO can be
selected only when you are working with the top-level COPY statement, and are not

valid when drilling down. Additionally, REBUILD and UNDO are available to you

only after you have made modifications to your selection.

If the text you selected contains any part of a macro, the text you selected is expanded
to include the entire macro down to the first line that is encountered that does not
contain a continuation character. Once you have expanded your source, you may
perf